Notices and Trademarks

Copyright 2010 by Honeywell International Inc.
Revision 5  February 2010

While this information is presented in good faith and believed to be accurate, Honeywell disclaims the implied warranties of merchantability and fitness for a particular purpose and makes no express warranties except as may be stated in its written agreement with and for its customers.

In no event is Honeywell liable to anyone for any indirect, special or consequential damages. The information and specifications in this document are subject to change without notice.

Honeywell, PlantScape, Experion PKS, and TotalPlant are registered trademarks of Honeywell International Inc.

Other brand or product names are trademarks of their respective owners.

Honeywell Process Solutions
1860 West Rose Garden Lane
Phoenix, AZ  85027
1-800 343-0228
Important Information for the User

- Changes or modifications not expressly approved by the manufacturer may void the user’s authority to operate the equipment.

- This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under law.

- If the Wireless Management Toolkit (Honeywell Server) software is shutdown, the RS-485 network **MUST be physically disconnected** from the PC as the serial port is no longer being controlled by the software and may disrupt communications between the Base Radio(s) and Analog/Digital Output Module(s).
About This Document

Revision Notes

The following list provides notes concerning all revisions of this document.

<table>
<thead>
<tr>
<th>Doc ID</th>
<th>Rel ID</th>
<th>Date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>34-XY-25-06</td>
<td>Rlse. 0</td>
<td>12/03</td>
<td>1st issue of document.</td>
</tr>
<tr>
<td>34-XY-25-06</td>
<td>Rev. 1</td>
<td>02/04</td>
<td>2nd issue of document.</td>
</tr>
<tr>
<td>34-XY-25-06</td>
<td>Rev. 2</td>
<td>06/04</td>
<td>Reformatted layout, updated technical information.</td>
</tr>
<tr>
<td>34-XY-25-06</td>
<td>Rev. 3</td>
<td>05/05</td>
<td>WMT Rev 3 Release.</td>
</tr>
<tr>
<td>34-XY-25-06</td>
<td>Rev. 4</td>
<td>08/06</td>
<td>Updated for version 1.70 software release.</td>
</tr>
<tr>
<td>34-XY-25-06</td>
<td>Rev. 5</td>
<td>02/10</td>
<td>Windows 7 System requirements added</td>
</tr>
</tbody>
</table>

Contacts

World Wide Web

The following lists Honeywell’s World Wide Web sites that will be of interest to our industrial automation and control customers.

<table>
<thead>
<tr>
<th>Honeywell Organization</th>
<th>WWW Address (URL/e-mail)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate</td>
<td><a href="http://www.honeywell.com">http://www.honeywell.com</a></td>
</tr>
<tr>
<td>Process Solutions</td>
<td><a href="http://content.honeywell.com/ps">http://content.honeywell.com/ps</a></td>
</tr>
<tr>
<td>Technical Assistance Center</td>
<td><a href="mailto:ask-ssc@honeywell.com">ask-ssc@honeywell.com</a> (e-mail)</td>
</tr>
</tbody>
</table>

Telephone

Contact us by telephone at the numbers listed below.

<table>
<thead>
<tr>
<th>Organization</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States and Canada</td>
<td></td>
</tr>
<tr>
<td>Honeywell Process Solutions</td>
<td>1-800-343-0228 Customer Service</td>
</tr>
<tr>
<td>Global Technical Support Center</td>
<td>1-800-423-9883</td>
</tr>
<tr>
<td>Outside United States</td>
<td>001-215 641-3610</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td></td>
</tr>
<tr>
<td>Honeywell Asia Pacific Inc.</td>
<td>(852) 8298298</td>
</tr>
<tr>
<td>Hong Kong</td>
<td></td>
</tr>
<tr>
<td>Europe</td>
<td></td>
</tr>
<tr>
<td>Honeywell PACE</td>
<td>[32-2] 728-2111</td>
</tr>
<tr>
<td>Brussels, Belgium</td>
<td></td>
</tr>
<tr>
<td>Latin America</td>
<td></td>
</tr>
<tr>
<td>Honeywell Inc.</td>
<td>(305) 364-2355</td>
</tr>
<tr>
<td>Sunrise, Florida U.S.A.</td>
<td></td>
</tr>
</tbody>
</table>
Table of Contents

1. INTRODUCTION .............................................................................................1
   1.1. USING THIS MANUAL .............................................................................1
   1.2. ABOUT THE SOFTWARE .........................................................................2
   1.3. UNPACKING ..........................................................................................2
   1.4. SYSTEM REQUIREMENTS .......................................................................3

2. QUICK START ................................................................................................4

3. INSTALLATION...............................................................................................6

4. THE HONEYWELL SERVER..........................................................................8
   4.1. RUNNING THE HONEYWELL SERVER.......................................................8
   4.2. ADDITIONAL HONEYWELL SERVER FUNCTIONS .....................................10

5. WHICH MODE SHOULD I RUN?.................................................................11
   5.1. MANAGEMENT MODE ...........................................................................11
   5.2. CONFIGURATION MODE .......................................................................11

6. RUNNING THE CLIENT SOFTWARE ..........................................................12
   6.1. LOCAL COMPUTER CONNECTION .........................................................13
   6.2. TCP/IP CONNECTION ..........................................................................13

7. FORMATTING AND MAINTAINING THE DATABASE.................................14

8. UNDERSTANDING THE USER INTERFACE ..............................................16
   8.1. THE FIELD UNIT (TRANSMITTER) VIEW .............................................16
   8.2. THE BASE & OUTPUT DEVICES VIEW ...............................................18
   8.3. THE TASKS VIEW ..............................................................................19
   8.4. THE ACCOUNTS VIEW .......................................................................20
   8.5. THE EVENTS AND CHAT LOG ..........................................................21

9. DEVICE MONITORING, CONFIGURATION AND DATA EXPORTING ......22
   9.1. MONITORING A TRANSMITTER ...........................................................22
   9.2. CONFIGURING A TRANSMITTER .........................................................24
   9.3. EXPORTING TRANSMITTER DATA ......................................................24

10. CONDUCTING A LINK TEST FROM WMT ..............................................26
Table of Figures

Figure 3-1: InstallShield Wizard ................................................................. 6
Figure 3-2: Software User Agreement Screen .............................................. 6
Figure 3-3: User and Organization Screen .................................................. 7
Figure 3-4: Installation Path Screen .............................................................. 7
Figure 4-1: Honeywell Server Icon ............................................................... 8
Figure 4-2: Honeywell Server Menu ............................................................. 9
Figure 6-1: The Honeywell Wireless Management Toolkit Client Desktop Icon .... 12
Figure 6-2: The Connection View ................................................................. 12
Figure 7-1: Database Storage Options .......................................................... 14
Figure 8-1: Field Unit (Transmitter) View ..................................................... 16
Figure 8-2: The Base & Output Devices View .............................................. 18
Figure 8-3: The Tasks View ....................................................................... 19
Figure 8-4: The Accounts View ................................................................. 20
Figure 8-5: Events Log ............................................................................. 21
Figure 8-6: Chat Log ................................................................................. 21
Figure 9-1: Field Unit Status View .............................................................. 22
Figure 9-2: The Data Export Wizard ............................................................ 24
Figure 9-3: The Data Export Wizard – Data Range ..................................... 25
Figure 9-4: The Data Export Wizard – Output File ..................................... 25
Figure 10-1: WMT Field Unit (Transmitter) View ....................................... 26
Figure 10-2: Wireless Data Loss Test ......................................................... 27
1. Introduction

1.1. Using This Manual
This manual is designed to assist in installing, operating, and maintaining Honeywell Wireless Management Toolkit software. The manual is broken into sections as follows:

Section 2: Quick Start
This section summarizes what must be done in order to get the software installed, configured and in operation quickly. However, it does not provide detailed or how-to information to perform the tasks outlined.

Section 3: Installation
This section explains how to correctly install, set up communications and run the software.

Section 4: The Honeywell Server
In order for the Wireless Management Toolkit to constantly record data from Transmitters and make this information available to the users, a program called Honeywell Server needs to be running on the computer the Base Radio Network is plugged into at all times. This computer will act as a server to users who wish to log on to the Wireless Management Toolkit and use the Client software.

Section 5: Which Mode Should I Run?
The Wireless Management Toolkit can be run in one of two modes: Configuration Mode or Management Mode. This section will aid you in choosing the mode which best fits your needs.

Section 6: Running the Client Software
Once you have set up and run the Honeywell Server, the Client software can be run from the computer on which the Honeywell Server is running, or the Client software can be run from a remote computer over a Network (TCP/IP) connection.

Section 7: Formatting and Maintaining the Database
Data from Transmitters is stored in databases on the Server. To accommodate the different needs of different users, there are a series of database options you should set.

Section 8: Understanding the User Interface
The Wireless Management Toolkit has multiple “Views” in which you can monitor and configure devices. This section will familiarize you with each of these views.

Section 9: Device Monitoring, Configuration and Data Exporting
This section explains how to monitor and configure devices. Also covered in this section is the ability of the Wireless Management Toolkit to export data in various formats for use with other applications.
1.2. About the Software

The Honeywell Wireless Management Toolkit software is a real-time network configuration and monitoring software package. The Wireless Management Toolkit allows you to quickly and accurately perform data acquisition at a fraction of the cost of a wired system with a PLC or DCS. In addition, the Wireless Management Toolkit allows for the remote configuration of Transmitters and Output Devices that would normally be done at the device level, saving time and money.

The Wireless Management Toolkit also has exporting capabilities for analysis functions, which give you bigger and faster returns on your wireless instrumentation investments. This software can be used for long term monitoring in remote locations, for short-term data gathering on process conditions, or to quickly test the economic viability of a new installation.

The purpose of this Guide is to help you install and maintain the Wireless Management Toolkit.

1.3. Unpacking

Remove the Packing List and check off the actual equipment received. If you have any questions on your shipment, please call your Honeywell Representative. Upon receipt of shipment, inspect the container for any signs of damage in transit. Especially take note of any evidence of rough handling. Report any apparent damage immediately to the shipping agent.

Please note that sometimes units are assembled with accessories when shipped. Inspect the shipment carefully if you think that something is missing. This is rare, as we take considerable care to pack units for shipment, but it does sometimes happen. Please give us a call and we may be able to resolve this matter quickly over the phone.

*Note* Please note that the carrier will not honor any claims for damage unless all shipping materials are saved for their examination. If damage is found during examining and removal of the contents, save the packing material and the carton.
1.4. System Requirements

Operating System Requirements:
- Windows® XP

Hardware Requirements:
- Processor: Recommend at least 1.0 GHZ
- Memory: 256 MB RAM or greater depending on the number of Transmitters being monitored
- Hard Disk Space: 150 MB for configuration, recommend 500 MB additional space if data collection is enabled
- Dedicated serial COM port, or USB port if using a Universal Link Cable

Operating System Requirements:
- Windows® 7

WMT is compatible with Windows 7 when it is installed to run in Windows XP Mode with Windows Virtual PC. These are free Microsoft downloads installed into Windows 7 which allow the WMT program to run in a virtual Windows XP environment within Windows 7. Windows XP Mode and Windows Virtual PC are available at http://www.microsoft.com/windows/virtual-pc/download.aspx

Windows XP Mode and Windows Virtual PC have the following system requirements:

Windows 7 Professional, Ultimate or Enterprise OS
32-bit or 64-bit edition

Minimum 1 GHz Processor, 2GB RAM and 15GB Hard Disk Space

Hardware-Assisted Virtualization Enabled
Most current PCs and many manufactured in the last 3 years have processors with this capability, but which is usually turned off by default. This feature can be verified by running Microsoft’s Hardware-Assisted Virtualization Detection Tool, and if so, whether it is enabled in the PC BIOS. This tool is available at http://www.microsoft.com/windows/virtual-pc/support/configure-bios.aspx
2. Quick Start

This section summarizes what must be done in order to get the software installed, configured and in operation quickly. It does not provide detailed or how-to information to perform the tasks outlined.


[2] Follow the installation instructions and install the software.


[4] When prompted (when run for the first time only) select Configuration Mode or Management Mode.

[5] Connect to the Honeywell Server, which is automatically launched via the following settings in the connection view:

- Local Computer
- 127.0.0.1
- Admin
- Password


[7] Each yellow device is an unconfigured device. Configure these devices with appropriate settings and tag names. Upon configuration these devices will turn green.

The following only applies if you chose Management Mode in number four in the above list:

[1] Set up user accounts and access levels via the **Accounts** view.

[2] Set up database management options via:

---

**View**→**Server Options**.

[3] Exit the software and verify that the blue and red RF icon remains running in the System Tray (lower right corner). This must remain running at all times if you want to log data into the database. It also must remain running if you want to log on to the Honeywell Server via a remote computer.

[4] You must find the IP Address of the Host computer. Follow the instructions below:

- Click on the Start button
- Select Run
- Type “cmd” into the command line and press return
- Record the IP Address, e.g. 192.168.1.66

The following applies if you are trying to log on to the Wireless Management Toolkit via a remote computer.

---

**Note** You must have selected Management Mode in task four above. If you did not select this mode go back to the Host computer, run the software, and under:

**View**→**Client Options** select **Management Tool**.
[1] Insert the Wireless Management Toolkit CD in the CD-ROM drive of the computer (this is called the Client computer).

[2] Follow the installation instructions and install the software.


[4] Connect to the Honeywell Server running on the Host computer via the following settings in the connection view:

- TCP/IP
- Enter IP Address of Host computer, e.g. 192.168.1.66
- Enter a User and Password of an account you set up

**Note** If your Base Radio is not plugged into COM Port 1 of the Host computer, then the user must right-click on the RF icon in the system tray (lower right corner) and select Options. This will allow the user to change the COM Port to the appropriate port number.

**Note** The Honeywell Server is run automatically (if it is not already running) when the software is launched and a user connects.

*If the software is run in Management Mode the Honeywell Server will not be shut down upon exiting the program, as it must remain running to collect data and allow users to login remotely.*

*To shut down the Honeywell Server, right-click on the RF icon in the system tray (lower right corner) and select Exit.*

*If the Honeywell Server is shutdown, the RS-485 network MUST be physically disconnected from the PC as the serial port is no longer being controlled by the software and may disrupt communications between the Base Radio(s) and Analog/Digital Output Module(s).*
3. Installation


[2] The InstallShield Wizard should be displayed on the monitor automatically as seen in Figure 3-1.

![Figure 3-1: InstallShield Wizard](image)

[3] Once the InstallShield Wizard is up and running, click **Next**.

[4] The following screen, shown in Figure 3-2, requires you to accept the license agreement.

![Figure 3-2: Software User Agreement Screen](image)

[5] Select **I accept the terms in the license agreement**, which indicates you have read and agree to the contents in the Software Site License Agreement.

[6] Click **Next** to move to the screen shown in Figure 3-3.
[7] Enter a User Name and Organization, and then click **Next**.

[8] Now, click **Install**. The InstallShield Wizard will now install the Honeywell software on the computer. The install process may take a few minutes.

[9] After the installation is complete the screen in Figure 3-4 will be displayed.

[10] Click **Finish** to exit the InstallShield Wizard and complete the installation.
4. The Honeywell Server

In order for the Wireless Management Toolkit to constantly record data from the Transmitters and make this information available to you, a program called Honeywell Server needs to be running at all times on the computer which the Base Radio is plugged into (the Host computer). This computer will act as a Host to all users who log on via remote computers.

Before starting the Honeywell Server, here is a list of terms that you should be familiar with:

**Honeywell Server** – a program that runs on the Host computer which stores all incoming data and provides this data to all the Clients logged in.

**Host computer**– the PC or server that the Base Radio is plugged into, and on which the Honeywell Server is being run.

**Client computer** – any computer that is running the Wireless Management Toolkit. The Client computer can be the same computer as the Host computer.

**Remote computer** – a computer that is connected to the Host computer via a TCP/IP network connection.

**Local Computer** – a connection type that is used when the Host and Client are the same computer. This means that the Client can find the Honeywell Server “locally”, (i.e., the same computer).

**TCP/IP** – a connection type that is used when the Client computer must use a network connection (e.g. an office intranet) to connect to the Honeywell Server running on the Host computer. This connection requires knowledge of the Host's IP Address.

### 4.1. Running the Honeywell Server

If you have not done so already, install the Wireless Management Toolkit. Then follow these instructions to run the Honeywell Server. From the Start menu, select:

*Programs* → *Honeywell WMT* → *Launch Server*

Once you have done this, you will see the Honeywell Server Icon in the Windows System Tray (usually found in the lower right corner like the one shown in Figure 4-1).

*Figure 4-1: Honeywell Server Icon*
Because the Honeywell Server is intended to run in the background and constantly monitor and record data from the Base Radio through the COM Port, it has a limited user interface that can be seen by right-clicking the Honeywell Server Icon (See Figure 4-2). To view the data being recorded the user can log on using the Client program (See Section 6 for more details).

![RF Manager Service](image)

**Figure 4-2: Honeywell Server Menu**

The Base Radio should be plugged into an available COM Port on the computer at this time. If you are using a Universal Link Cable, a USB port may be used. Right-click the RF Sever icon and select **Options** to configure the appropriate Port. The default is COM Port 1. In order for the Wireless Management Toolkit to receive data from the Base Radio, the Honeywell Server must be running on the Host computer. If this is not the case no data will be recorded, and you will not be able to connect and run any Clients from remote computers or the local computer.

If you wish to shut the Honeywell Server application down, right-click on the Honeywell Server icon and select **Exit**. Note that you must restart the Honeywell Server on the Host computer in order to receive data and run the Client software. Also, the RS-485 network MUST be physically disconnected from the PC as the serial port is no longer being controlled by the software.

In order to allow the Client software to find the Honeywell Server, you must also specify where the Honeywell Server is located. If the Client and Host are the same computer the connection type is Local Computer. If the Client is a remote computer the connection type is TCP/IP and the IP Address of the Host computer must be specified.

To find the IP Address of the Host computer follow these instructions:

- Click the Start button
- Select Run
- Enter “cmd”
- Enter “ipconfig” into the command line and press return
- Record the IP Address, e.g. 192.168.1.66
The Honeywell Server program must remain running to collect data and allow users to login remotely.

If the Honeywell Server is not running on the Host computer, users will not be able to log in.

Also, a single user account cannot be logged on to the Honeywell Server from more than one computer at a time.

### 4.2. Additional Honeywell Server Functions

The following functions are also available from the Honeywell Server menu (See Figure 4-2).

**About** – Contains the software version number.

**Reset Passwords** – Resets the Admin password to password and deletes all of the other user accounts.

**Reset Database** – Resets the database to the default values. This will also delete all logged Transmitter data.

**Compact Database** – Runs a Microsoft Access function to compact the database. Use this to help save hard disk space if your database is getting large.

**Discover Devices** – Searches for any new devices that have been added to the Wireless Network. It is recommended to run Discover Devices after adding any new devices.

**Delete Transmitter** – Removes a Transmitter from WMT Client and from the Configuration database. Any previously collected data from that Transmitter is NOT deleted. However, this data is not accessible through WMT and may only be viewed from the Access Database until the Transmitter is rediscovered by WMT. If you do not wait for the Transmitter to enter "NO RF" status, the Transmitter may be immediately rediscovered by WMT.

**Options** – Opens the RF Manager Service Configuration dialog box. This is used to configure a port.

**Restart Server** – Stops and restarts Honeywell Server.

**Exit** – Stops Honeywell Server.

---

**Note** If you experience mouse issues, unplug and plug in the Base Radio. Also do not leave the Base Radio plugged in while rebooting the computer as this will cause the PC to recognize the Base Radio as a mouse and move the pointer erratically. Instead wait until you are ready to run the software.
5. Which Mode Should I Run?

The Wireless Management Toolkit can be run in one of two modes:

- Configuration Tool mode
- Management Tool mode

This section will aid you in choosing the mode which best fits your needs.

These modes are called Client Options. When the Wireless Management Toolkit is run for the first time you are asked to make this decision. However, you can change this setting at any time by selecting Client Options from the View menu at the top of the program window.

5.1. Management Mode

The Management Tool setting should be used when the user wishes to only monitor and configure a single Wireless Instrumentation network. In Management Mode:

- Data is stored in the database and NOT deleted when Honeywell Server is shut down (Sec. 7)
- Multiple users can log in from remote computers (Sec. 6)
- User accounts and security levels can be created (Sec. 8)
- User can connect via Local Computer and TCP/IP (Sec. 6)
- Requires user to manage database size and settings (Sec. 7)
- Honeywell Server remains running when Client is closed (Sec. 4)

One important note is that regardless of the mode, when an output device is connected its settings will always be downloaded from the device into the WMT database.

*Note* Once the Wireless Management Toolkit is connected to a wireless network and the Wireless Management Toolkit is in Management Mode, certain Transmitter menus will no longer be locally accessible via the Next and Enter buttons. This is done to prevent Transmitter settings from being changed without the Administrator's knowledge.

5.2. Configuration Mode

The Configuration Tool setting should be used when the user wishes to plug into existing networks, (or move from network to network) in order to configure units without retaining the gathered data that is accumulated while the Honeywell Server is running. In Configuration Mode:

- Data is stored in the database and DELETED when Honeywell Server or the Client software is shut down (Sec. 7)
- Users CANNOT log in from remote computers (Sec. 6)
- User accounts CANNOT be created (Sec. 8)
- User can connect via Local Computer only (Sec. 3)
- User does not need to manage the database size (Sec. 7)
- Honeywell Server is shut down when the Client software is shut down (Sec. 4)

Another important distinction is that, unlike the Management Mode, the Configuration Mode does not save all the configuration data for the network. In this mode the software simply gathers as much configuration information from the network as it can. When configuration changes are made to any of the devices via the software, these changes are downloaded to the devices and preserved.
6. Running the Client Software

The Wireless Management Toolkit client software is the application that is used to connect to the Honeywell Server in order to configure and monitor devices. This software can be run on the Honeywell Server Host computer or it can be run on a remote computer and connected to the Honeywell Server via a TCP/IP connection. Both cases are covered in this section.

Once you have installed the software, the Wireless Management Toolkit Client icon appears on the desktop. It is labeled Honeywell Wireless Management Toolkit:

![Figure 6-1: The Honeywell Wireless Management Toolkit Client Desktop Icon](image)

Double-click the Honeywell Wireless Management Toolkit Client icon to start the Wireless Management Toolkit. The Wireless Management Toolkit can also be started through the Start menu:

**Programs → Honeywell WMT → Honeywell Wireless Management Toolkit**

Once the Client software has been started, the Connection View will be displayed. This view is shown in Figure 6-2.

![Figure 6-2: The Connection View](image)
6.1. Local Computer Connection

The Wireless Management Toolkit has two Client connection options. The first is Local Computer Mode. This mode should be used when running the Client on the same computer on which the Honeywell Server is running. (See Section 4 for more details)

Since the Client can find the Honeywell Server on the same computer from which it is being run, it is said that the Honeywell Server is being run “locally” or on the same computer. This type of connection does not require an IP Address to be specified. A Local connection is performed as follows:

- Connection: Local Computer
- Server: N/A
- User: Admin
- Password: password

Note If you have selected to run in Configuration Tool Mode then the connection type is limited to Local Computer. (See Section 5 for more details.)

6.2. TCP/IP Connection

The second Client connection option is the TCP/IP Mode. This mode should be used when the Honeywell Server is being run on a different computer and the user wishes to log in via a network connection on their computer.

Since the Client must find the Honeywell Server via a network, the Client must be given an IP Address where the Honeywell Server can be found. (To find the Host computers IP Address, see Section 3.) This type of connection is called a TCP/IP connection. A TCP/IP connection is performed as follows:

- Connection: TCP/IP
- Server: 192.168.1.88 (for example)
- User: Admin or any created user account
- Password: password

Note If the Honeywell Server is not running on the Host computer, you will not be able to log in. Also, a single user account cannot be logged into the Honeywell Server on more than one computer at a time.
7. Formatting and Maintaining the Database

Every transmitted sample of every Transmitter is logged into a Microsoft Access database through the Wireless Management Toolkit. Because the number of Transmitters and frequency of data transmission varies with each Wireless Instruments installation, the rate at which this database grows also varies. To accommodate the different needs of different users, there is a series of database options that should be set.

To configure these options, select **Server Options** from the **View** menu. The following dialog box appears:

![Database Storage Options](image)

*Figure 7-1: Database Storage Options*

The settings shown in Figure 7-1 are the default settings of the data storage options. The Save Data check-box allows the user to enable or disable the saving of incoming Transmitter data in the database.

If you do not want to export data, generate reports, save device configuration data, or see graphs of past Transmitter values, clear the Save Data check box. Doing so will still allow the user to monitor alarms and real-time streaming data. No Transmitter history will be kept.

If you want to see past Transmitter data graphs or export data, select the check box to save the incoming data. Note that this will use a greater amount of hard drive space depending on the resolution options you have selected.

If you have chosen to save data then you should also set the high and low resolution data settings according to your demands. A description of the function of each setting is located below the settings.
• High-resolution data consists of a data point for every transmitted value by every Transmitter and is stored in FieldUnitRawData.mdb.
• Low-resolution data consists of one minute's worth of data points averaged to one data point for each Transmitter and is stored in FieldUnitData.mdb.

If you wish to preserve the database beyond the 90-day low-resolution data limit, you must make a copy of the low-resolution database file. This file, FieldUnitData.mdb, is installed in the following directory: HoneywellWMT\Database. You can copy and paste the database in any folder you choose. It is suggested you rename the saved database with the date range, (e.g., Jan-Feb 2005).

If you run out of hard drive space due to the size of the database you may have to reduce the length of time that the low-resolution data is retained. Doing so will reduce the size of the database.

**Note** If you have opted to run the Wireless Management Toolkit in Configuration Tool Mode, the database will only store data while the Client software and Honeywell Server are running. Upon closing these programs, all saved configuration and sample data will be deleted.
8. Understanding the User Interface

Once you have connected the software to the Honeywell Server (Sections 4 and 6), you are able to view different types (or views) of data. These include the Connection, Transmitters, Base & Output Devices, Tasks, and Accounts views. To select these views click, on their respective icons in the Views pane located on the left hand side of the Client program. The Events and Chat Log appears in every view and is covered in Section 8.5.

Transmitters are also referred to as Field Units. The following sections will step through each of these views and describe their functionality and features:

8.1: The Overall Field Units’ Conditions
8.1.2: The Selected Field Unit Condition
8.1.3: The Field Unit Group Tree
8.1.4: The Field Units Group Tree
8.2: The Base & Output Devices View
8.3: The Tasks View
8.4: The Accounts View

8.1. The Field Unit (Transmitter) View

The view you will see upon connection is the Field Unit View. This view shows the Transmitter information, and allows you to configure and view individual Transmitter data. This view can be accessed at any time by clicking on the Field Units icon in the Views pane. The Field Unit View is shown in Figure 8-1.

![Figure 8-1: Field Unit (Transmitter) View](image)

Each of the four numbered areas in Figure 8-1 is explained in the following sections in order.
8.1.1. #1 - The Overall Field Units' Conditions
The Overall Field Units Conditions box refers to all Transmitters that are on the network. This box tells the user the total number of Transmitters there are, how many Transmitters are in an alarm condition (red), and how many Transmitters are in a warning condition (yellow or orange).

Note The installation and configuration of the individual Transmitters via the Wireless Management Toolkit is covered in the respective Transmitter User Manuals. Please see these manuals for more specific details regarding these devices.

8.1.2. #2 - The Selected Field Unit Condition
The Selected Field Unit Conditions box is different from the Overall Field Unit Conditions box, in that the Selected Transmitter shows only the condition of the Transmitter that is selected in the Field Units Pane. This box shows the Transmitter type and the current condition:

- **Green** - All systems are configured and OK. No Alarms
- **Yellow** - The Transmitter is un-configured
- **Orange** - There is a system warning with the Transmitter
- **Red** - An Alarm is being exceeded

8.1.3. #3 - The Field Units Pane
The Field Units Pane shows all the Transmitters in the selected group from the Field Units Group Tree (#4). Each Transmitter in this pane has a color that indicates its current condition (see above for color description). In addition, the following information is displayed: Tag Name, Monitored Equipment, ID (See Note), Device Type, Status of the Transmitter, and the current Primary and Secondary Values that the Transmitter is reading. (For more information on how to configure and monitor individual Transmitters see Section 9).

Note Transmitters are often referenced throughout the software by two numbers, such as 1-1 in Figure 8-1. The first number refers to the Base Radio ID and the second number refers to the Transmitter RF ID.

8.1.4. #4 - The Field Units Group Tree
The Field Unit Group Tree allows the user to select and group which Transmitters are displayed in the Field Units Pane (#3).

- **All Field Units** view is the default view and displays a scrollable list of every Transmitter that has been discovered on the network.
- **Alarming Field Units** view displays only Transmitters that are in an alarm condition (discussed in the Transmitter Configuring and Monitoring section).
- **Unconfigured Field Units** view displays Transmitters that have been discovered on the network, but have not been renamed or configured.
- **Field Unit Groups** view allows the user to assign Transmitters to individual groups, and then view the Transmitters by those groups. Groups are added by right clicking on the Field Unit Groups folder and selecting Add Child Group. Deleting and Renaming of groups is done in the same fashion. To add Transmitters to a group, click the desired Transmitter and drag and drop it to the appropriate group folder.
- **Base Radios** view displays the Transmitters that are associated with the selected Base Radio.
- **Field Unit Types** view displays each set of Transmitters on the network by type, e.g. Acoustic Transmitter.
8.2. The Base & Output Devices View

This view shows the Base Radio and optional Analog/Digital Output Devices. This view can be accessed at any time by clicking on the Base & Output Devices Icon in the Views pane. The Base & Output Devices View is shown in Figure 8-2.

Figure 8-2: The Base & Output Devices View

The Base & Output Devices view allows you to rename and view data about each of your Base Radios as well as any optional Analog/Digital Output Modules you have installed on the RS-485 network (see the Analog/Digital Output Module User Manual for more information on installation on configuring this device).

The RF Channel and Number of Transmitters communicating with each Base Radio are listed under the Base Radio pane. ID and output Device Type are listed for each Analog/Digital Output Module under the Output Device pane.

**Note** If you have added a new device such as Transmitter or Analog/Digital Output Module to an existing wireless network the device may not show up automatically in the Client software. To force the program to search for new devices click **Discover Devices** under the **File** menu.
8.3. The Tasks View

The Tasks view shows the scheduled tasks that need to take place, such as configuration information to be uploaded to the Transmitters. This view can be accessed at any time by clicking on the Tasks icon in the Views Pane.

![Tasks View Image]

Figure 8-3: The Tasks View

The importance of the Tasks view is to let the user know when the configuration changes made to the Transmitter have been successfully downloaded to the Transmitter. Thus, the user cannot expect to see the configuration changes at the unit until the task is completed.
8.4. The Accounts View

The Accounts View allows management of all the user accounts. This view can be accessed at any time by clicking on the Accounts Icon in the Views Pane. However, only those with Administrative Access can make changes in this view. The Accounts View is shown in Figure 8-4:

![Accounts View](image)

**Figure 8-4: The Accounts View**

This view allows the addition, deletion, and editing of user accounts to the software. Clicking Add allows the user to add a new user account. When adding a new account a name, password, and level of access must be given.

There are three levels of access that can be granted to a user:

- **Administrative** – able to make changes to anything.
- **Read/Write** – able to view data and change Transmitters and Base Radio outputs and thresholds.
- **Read Only** – able only to view the collected Transmitter data and the current configurations. Not allowed to make changes.

User accounts can be deleted by selecting the user account in the left-hand column and clicking the Remove button. User access levels and passwords can also be changed by selecting the user account in the left hand column and clicking the Update button.

**Note** If security is an issue, the Admin (or manager of the Wireless Network) should log in under the Admin account and setup new accounts for all users. The Admin account should then be deleted.

The Wireless Management Toolkit security, much like many programs, is only as good as the Host computers security. If security is an extreme issue then the Host computer should be accessible to the Admin only.
8.5. The Events and Chat Log

At the bottom of every view the Events or Chat Log is displayed. The view of either of these is toggled by clicking either of the labeled tabs in the lower left hand corner of the Client software.

The Events Log records the last 50 changes that were made to the network (e.g. addition of new Transmitter, changing of Transmitter status). Each of these events is logged with a description, as well as a time and date stamp. The Events Log is shown in Figure 8-5:

![Figure 8-5: Events Log](image)

The Chat Log allows the user to chat with all users on the network and see which users are currently logged into the Honeywell Server via the Client program. The chat log works by posting a message to the user and allowing them to reply, much like an instant messenger service. To type a message, click in the bottom frame and type. Press Enter to send the message. The Chat Log is shown in Figure 8-6:

![Figure 8-6: Chat Log](image)
9. Device Monitoring, Configuration and Data Exporting

Each device has its own monitoring, configuration and data exporting capability within the Wireless Management Toolkit. The purpose of this section is to give the user an overview of how to use these capabilities.

The following sections will step through each of these capabilities and describe their functionality and features. The section outline is as follows:

9.1: Monitoring a Transmitter
   9.1.1: Field Unit Data Graphs
   9.1.2: Software Alarm Thresholds
   9.1.3: Field Unit State
   9.1.4: Field Unit Primary & Secondary Values

9.2: Configuring a Transmitter

9.3: Exporting Transmitter Data

9.1. Monitoring a Transmitter

Each Transmitter has its own monitoring capabilities, which can be accessed through the Field Unit view. See Section 8.1 for more details on the Field Unit view.

When in the Field Unit view, double-clicking (or right-clicking and selecting View Field Unit Data) on a particular Transmitter’s icon will bring up that Transmitter’s Status Window as shown in Figure 9-1. The data and fields will differ based on the type of Transmitter that is selected. The screen shot in Figure 9-1 shows data for an Acoustic Transmitter.

Figure 9-1: Field Unit Status View
In Figure 9-1 above has been numbered from one to four. Each of the following subsections will cover these areas of the Field Unit Status view.

### 9.1.1. #1 - Field Unit Data Graphs

The Field Unit data graphs show the current and all past data that is available in the Transmitter database. The upper graph is the Primary process variable (shown as Ultrasound in Figure 9-1), and the lower graph is the Secondary process variable (shown as Temperature in Figure 9-1). All process value points are shown in blue if they are within a user selected alarm threshold (indicated by a red line). Any data points exceeding an alarm threshold appear in red. These alarms can be set in the Field Unit **Configuration** menus under the **Alarms** tab.

The Y-axis resolution of the data graphs may be changed in the Field Unit **Configuration** menus under the **Range** tab.

The data graphs can be panned and zoomed via the control buttons located below the graphs. The graphs can also be specified to show a user selectable data range by using the **Specify Range** button.

If at any time you would like to see the most current data simply click the **Show Current Data** button.

**Note** If the save data option for the database is disabled the graphs will not show any data. (See Section 7 for more details on database management).

Any missing data on the graphs will appear as a gray area. If the user has selected to run the software in Configuration Mode, only data gathered during the current run of the software will be displayed, as all database data is deleted when the software is shut down in this mode. (See Section 5 for more details).

### 9.1.2. #2 - Software Alarm Thresholds

The Alarm Thresholds refer to alarm set points that have been set in the Wireless Management Toolkit Field Unit **Configuration** menu to warn the user of important changes in the Primary and Secondary process values. There are 4 alarm thresholds available for a single process variable unit, and there are 2 alarm thresholds available for each process in a dual process variable unit. The alarm thresholds are set in the Field Unit **Configuration** menu under the **Alarms** tab.

**Note** The software alarms exist only within the Client software. These alarm thresholds are **NOT** downloaded into any devices, thus these alarms are not displayed on the Transmitter LCD’s.

The purpose of these alarms is to notify a user looking at the Client software when possible alarm conditions occur.

### 9.1.3. #3 - Field Unit State

The Field Unit State box gives the user the time of the last update received from the Transmitter. All other information contained within the State box is specific to the time of the last update time.

The green “OK” message will change to a red exclamation point if the respective status reading is in concern or if either of the process values is above an alarm threshold.

### 9.1.4. #4 - Field Unit Primary & Secondary Values

The current Transmitter primary and secondary values are shown via graph levels in blue. If a process variable were exceeding a user set alarm threshold, the graph level would appear in red.
9.2. Configuring a Transmitter

The Wireless Management Toolkit allows for the configuring of Transmitter settings that would normally be done using the Next and Enter buttons on the individual Transmitter. These changes are done via the Configuration menu.

The Configuration menus are displayed by clicking on the Configure button in the Field Unit’s Status View (See Figure 9-1) or by right clicking on the Transmitter icon within the Field Unit View and selecting Configure. Doing so will bring up the Configure Menu.

Because each Transmitter has different configuration options available, the directions on how to configure a particular Transmitter are located within the respective Transmitter’s User Guide. Please see the individual Transmitter User Guides for more details on how to configure these devices using the Wireless Management Toolkit.

*Note* Once the Wireless Management Toolkit is connected to a wireless network and the Wireless Management Toolkit is in Management Mode, certain Transmitter menus will no longer be locally accessible via the Next and Enter buttons. This is done to prevent Transmitter settings from being changed without the Administrator’s knowledge. (See Section 5 for more details on the Management Mode setting).

9.3. Exporting Transmitter Data

The export function allows you to export Transmitter data from the database to a separate file for use with different data analysis tools. You can export data in comma-separated value (.CSV) or text (.TXT) formats.

To export data for a Transmitter, click on the Exports button in the Field Unit’s Status View (See Figure 9-1) Doing so will bring up the export wizard as shown in Figure 9-2

![Figure 9-2: The Data Export Wizard](image)

Upon entering the Export Data Wizard, the user is prompted to select the fields of data to be exported. To select a field, highlight the field in the left-hand column and click the right-pointing arrow. To remove a field from the export list, highlight that desired field and click the left-pointing arrow.

After selecting the fields to be exported, click Next. Then you are prompted to enter the date range for the data, in Figure 9-3.
After entering the data range, click **Next**. Finally, you are asked to select an export file type and enter a file name, in Figure 9-4.

Click **Start** to begin the data export.

**Note** The export option is only available if the data save option for the database has been enabled (see Section 7 for more details on database management).
10. Conducting a Link Test from WMT

To conduct a Link Test from WMT, make sure that WMT is running on the PC attached to the Base Radio. Then go to the Field Unit (Transmitter) view, and right-click on the Transmitter you want to test Received data transmission from (Figure 10-1).

Select Wireless Link Test... from the popup menu. The Wireless Link Test window appears in Figure 10-2. The name of the Transmitter being tested appears in the title bar in parentheses.
In the top of the window, you can configure the test to run for a specified amount of time. The longer the test, the more data the test will have to do an evaluation. Type the length of time that you want to run the test and click Begin to start. Once the test starts, WMT will disable the smart-rate and abnormal transmit rate settings. After the test has completed, it will restore the settings to their previous values.

During the test, the communications reliability is evaluated while the Transmitter is running under normal operating conditions. As the test runs, a link strength will be shown in the lower right hand corner of the window. >>>>>> indicates the strongest link, while > indicates the weakest link. The Link Test will continue to be evaluated and the rating on the screen may adjust itself for the specified amount of time.